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Getting Started

Disk Copy 6.1.2 is a utility application that will mount disk images on your
desktop, make exact copies of fl oppy disks from a disk image, convert disk images
from one format to another, and create a disk image from a mounted volume or
individual folder. Using DiskScripts and AppleScript, it can be used to automate
software installations and disk image manipulation.

System requirements and supported features
Disk Copy 6.1.2 requires System Software 7.0.1 or later and is a “fat binary” for
both PowerPC and 68K-based Mac OS compatible computers. Macintosh
Application Environment 3.0 Update 4 or later is also supported; A/UX is not
supported. Disk Copy 6.1.2 features extensive Balloon Help and supports Drag and
Drop (requires System Software 7.5 or later), AppleScript, PlainTalk Text-toSpeech, and DigiSign digital signatures.

Installing Disk Copy 6.1.2
Disk Copy 6.1.2 can reside anywhere on your hard disk. It is recommended to place
an alias to it on the desktop for easy access.
Disk Copy 6.1.2 requires the ObjectSupportLib and AppleScriptLib extensions on
PowerPC-based computers (they are included in a standard System Software
install). These files can be located in the Extensions folder of the System Folder or
in the same folder as Disk Copy 6.1.2.

Remove any copies of Disk Image Mounter and Disk Copy 6.0.1
Disk Copy 6.1.2 provides all the functionality of Disk Image Mounter, a utility that
was included with some PowerBook models. Disk Copy 6.0.1 was released only to
developers and Support Professional Solution Series subscribers. To avoid
problems working with disk images, it is important to remove all copies of both
Disk Image Mounter and Disk Copy 6.0.1 and rebuild your desktop after installing
Disk Copy 6.1.2. If you have upgraded from Disk Copy 6.1, you may also want to
rebuild your desktop; some of the icons in Disk Copy 6.1.2 have been revised.
While Disk Copy 6.1.2 also features the functionality of Disk Copy 4.2 and Floppy
Disk Maker, neither of these utilities will interfere with Disk Copy 6.1.2 and do not
need to be removed.

Getti ng Sta rted
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Disk Copy 6.1.2 Basics

About disk images
A disk image is a discrete electronic representation of an individual volume; the
image contains all the information to make an exact duplicate of the original. A
copy made by dragging icons is not an exact copy; there may be invisible files or
other i nformation that is not copied. When you use disk images, the volume as a
whole has been duplicated co rr e ctly and completely.
Making disk images of floppy disks is also a convenient and safe way to make
backups of original master disks from purchased software packages and allows you
to electronically distribute the contents of disks.

Disk image formats
Disk Copy 6.1.2 can read and write three types of NDIF (New Disk Image Format)
disk images, Disk Copy 4.2 disk images, as well as read other disk image formats.

Disk Copy 6.1.2 can
read NDIF disk
images created by
Disk Copy 6.0.1, but
NDIF disk images
created by Disk Copy
6.1 or 6.1.2 are not
backwards
compatible.

Format

Description

Read/Write
NDIF

Disk images in this format will allow you to make changes when mounted as if
they were actual floppies or hard disks. Disk image size for this format can vary
from a minimum of 401K to a maximum of 2GB.

Read-Only
NDIF

Disk images in this format will allow you to open files and run applications when
mounted, but not make any changes as if they were locked floppy disks or
CD-ROMs. Read-Only image format is similar to disk image formats you may
have worked with previously, except it truncates any empty space, resulting in
smaller disk images, and disk image size can vary from a minimum of 401K to a
maximum of 2GB. This format also includes a checksum.

Read-Only
Compressed
NDIF

Disk images in this format function the same as Read-Only but in addition to
truncating any empty space, the Read-Only Compressed format compacts the
data in the disk image, resulting in even smaller disk images. Disk Copy 6.1.2
provides extremely fast decompression so the only extra time necessary is
during compression. This format is a good choice for disk images that will be
downloaded. Disk image size for this format can vary from a minimum of 401K
to a maximum of 2GB and includes a checksum. Macintosh Plus, SE, Classic,
Portable, and PowerBook 100 computers can mount and make floppies from,
but cannot create, a Read-Only Compressed format disk image.

Disk Copy 4.2

Disk images in this format work the same as the Read-Only format but are
compatible with the previous version of Disk Copy and many third party disk
image utilities. Disk Copy 4.2 format only supports 720K, 800K, and 1.4MB
floppy sizes. This format also includes a checksum.
c on t i n ue s .
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Format

Description

PC Drive
Container

Disk Copy 6.1.2 will mount as read/write, but does not create disk images in this
format. Container files are created by Apple’s PC Compatibility software, which
works only on DOS-Compatible Mac OS computers.

DART

Disk Copy 6.1.2 will read, mount, and convert from, but does not create disk
images in this format. DART is an older Apple utility for working with disk images
which creates compressed disk images.

ShrinkWrap
Floppy

Disk Copy 6.1.2 will read, mount, and convert from, but does not create disk
images in this format. ShrinkWrap (versions 2.1 and earlier) floppy format is
nearly identical to Disk Copy 4.2 format.

ShrinkWrap
Volume

Disk Copy 6.1.2 will read, mount, and convert from, but does not create disk
images in this format. ShrinkWrap (versions 2.1 and earlier) volume disk
images are not floppy size and do not have a checksum.

DOS and ProDOS-formatted disk images
Disk Copy 6.1.2 requires PC Exchange to work with disk images that contain DOS
or ProDOS volumes, such as a PC drive container or a DOS-formatted floppy.
To make DMF (a 1.7 MB PC format) floppies, Disk Copy requi res a SuperDrive
and Mac OS 7.6 or later, which includes PC Exchange version 2.1.1 or later.

Mounting disk images
Instead of making floppies from disk images to copy files or install software, for
example, Disk Copy 6.1.2 allows you to have disk images appear on the desktop as
if you had made a floppy and inserted it into the floppy drive.
Mounting is also the only way to work with disk images that are larger than a
floppy. Working with mounted disk images is as fast as working with a hard drive
and you no longer need a stack of floppies.

Verification and authentication
Disk Copy 6.1.2 supports two methods to ensure the integrity of disk images:
checksums and digital signatures.
A checksum is a number derived from looking at the data that makes up the disk
image. It is stored in the disk image itself. If any changes are made to the disk
image, the checksum will change as well. When Disk Copy 6.1.2 begins to work
with a disk image, it can optionally verify that checksum has not changed to ensure
no data corruption or alteration has occurred.
Digital signatures are used to approve, or “sign,” files to assure its authenticity.
DigiSign software is part of, but does not require, Apple’s PowerTalk software.
The ch ecksum allows Disk Copy 6.1.2 to verify the contents of a disk image, while
the signature allows authentication of the source of the disk image.

Dis k C opy 6. 1.2 Ba sics
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Disk Copy 6.1.2 main window

File name of the last
disk image, the name
of the volume within
it, the validity of the
checksum, and if the
DigiSign extension is
installed, the digital
signature status.

Results of the last
action performed.

Image and volume name
These lines show the file name of the disk image last operated on and the name of
the volume contained within the disk image, res pe ctively.

Checksum status
The ch ecksum line will display one of the following messages:
m “VALID ([image type] calculated [checksum])”: The selected disk image has
not been altered or damaged and is safe to use.
m “ IN VALID ([image type] expected [ch ecksum])”: A checksum fails usually
because the disk image is corrupt. Disk Copy 6.1.2 will most likely warn you the
image is damaged and cannot be used instead of displaying this message.
m “not ch ecked ([image type] expected [ch ecksum])”: The Verify Checksum
option is deselected in the Preferences dialog box.
m “none”: Many other disk image utilities do not add a checksum to some disk
images they create. This does not mean the disk image is corrupt; there is
simply no way to verify its integrity.

DigiSign status
The DigiSign line will appear if the DigiSign extension is installed and display
one of the following messages:
m “VERIFI ED”: The selected image has not been altered since it was signed. T his
line will also indicate if the signer has expired (signatures must be renewed).
m “ IN VALID”: The selected image has been altered since it was signed.
m “signed, not checked”: The disk image is signed, but the Verify Signature option
is deselected in the Preferences dialog box.
m “not signed”: The disk image does not have a digital signature.
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Using Disk Copy 6.1.2

Mounting disk images
1

To mount a disk image, do any of the following:

m Select one or more disk images and double-click. This only works for NDIF
images (Read/Write, Read-Only, and Read-Only Compressed).
m Select one or more disk images and drag into the Disk Copy 6.1.2 main window
(requires System Software 7.5 or later).
m Select one or more disk images and drag onto the Disk Copy 6.1.2 application
icon.
m Choose “Mount Image...” from the Image menu and select a disk image.

Click to verify the
checksum of the
selected disk image.
If the checksum fails,
the disk image will
not be mounted.
Click to verify the
signature of the
selected disk image.
If the signature is
invalid, the disk
image will not be
mounted.

After a disk image is selected, Disk Copy 6.1.2 will present a progress dialog for
mounting and checksum verification (if the option is selected), and an icon for the
mounted volume will appear on the desktop.
Icon for the volume contained
in the disk image as shown
mounted on the desktop.

Using D isk Copy 6.1.2
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You can now work with the mounted volume as you would any regular volume. To
unmount, either drag the icon to the Trash or select the icon and use the “Put
Away” command from the File menu. When you restart you computer, any
mounted disk images will be unmounted.
2

To see how your computer recognizes the data on the mounted volume, select the icon for the
mounted volume in the Finder and choose “Get Info” from the File menu.

The “Kind” and “Size”
items appear as they
would for any floppy,
hard disk, or CDROM, but the
“Where” item shows
that the volume “Disk
Tools” is contained in
the disk image “1.4
MB Disk Image”
which is on the
volume “Disk Copy.”

In the example below, you can see how a mounted disk image is a “virtual disk” to
your computer. What looks like a disk on the desktop is actually a disk image.

Data that appears on
the mounted volume
“Disk Tools” is
actually in the disk
image named “1.4
MB Disk Image,”
which is on the hard
disk volume “Disk
Copy,” so reading
and writing data to
and from the
mounted image will
be as fast as from the
hard disk.
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Making floppies from disk images
1

To make a floppy from a disk image, do any of the following:

m Select one or more disk images and double-click while pressing the Option key.
This only works for NDIF images (Read/Write, Read-Only, and Read-Only
Compressed).
m Select one or more disk images and drag into the Disk Copy 6.1.2 main window
while pressing the Option key (requires System Software 7.5 or later).
m Select one or more disk images and drag onto the Disk Copy 6.1.2 application
icon while pressing the Option key.
m Choose “Make a Floppy...” from the Utilities menu and select a disk image.

When making
floppies, Disk Copy
always verifies the
checksum of the
selected disk image.
If the checksum fails,
the floppy will not be
made.
Click to verify the
signature of the
selected disk image.
If the signature is
invalid, the floppy will
not be made.

Only images that contain floppy-size volumes will appear in this dialog box; larger
size volumes can only be mounted or converted.
Disk Copy 6.1.2 requires PC Exchange to make floppies from disk images that
contain DOS or ProDOS volumes, such as a PC drive container or a DOSformatted floppy.
To make DMF (a 1.7 MB PC format) floppies, Disk Copy requi res a SuperDrive
and Mac OS 7.6 or later, which includes PC Exchange version 2.1.1 or later.
After a disk image is selected, Disk Copy 6.1.2 will present a progress dialog for
checksum verification and ask you for a floppy that is the same size as the disk
image. You cannot, for example, use a 1.4 MB floppy to make an 800K volume.
When making floppies, Disk Copy 6.1.2 uses more memory that its default memory
setting. If there is not free RAM available, Disk Copy 6.1.2 will not be able to make
the floppy and will present an error message. Either quit other running
applications or increase Disk Copy’s Preferred memory size to 2048K.

Using Di sk C opy 6. 1.2
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Click Stop or press
Command-Period or the
Esc(Escape) key to stop.

If you i nsert a floppy that has been previously formatted and the Confirm Erases
option is se lected in the Preferences dialog box, Disk Copy 6.1.2 presents a dialog
box asking you to confirm before erasing the floppy and copying new data to it.

Click Cancel or press
Command-Period or
the Esc (Escape) key
to stop.

Click Yes or press CommandShift-Y to erase the disk and
copy new data to it.

2

Click or press Return or
Enter to eject the current
floppy and use another.

Click the appropriate button to proceed or cancel.

Disk Copy 6.1.2 will eject the floppy when it is finished. If the Make Multiple
Floppies option is selected in the Preferences dialog box, Disk Copy 6.1.2 will
present a dialog box asking for the next floppy to make.
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Creating disk images
1

To create a disk image, do any of the following:

m Select one or more folders or disks and drag into the Disk Copy 6.1.2 main
window (requires System Software 7.5 or later). Each folder and disk will be
made i nto a separate disk image.
m Select one or more folders or disks and drag onto the Disk Copy 6.1.2
application icon. Each folder and disk will be made into a separate disk image.
m Choose “Create Image from Folder...” from the Image menu and select a folder.

After a folder is selected, Disk Copy 6.1.2 will calculate the size of the data in the
folder and use that as the default disk image size.

The only exception to this is folders that contain less than 401K of data; the
minimum disk image size is 401K and Disk Copy 6.1.2 will default to that size.
However, saving in either Read-Only or Read-Only Compressed format will result
in a disk image that is closer to the actual size of the data, as both formats tr uncate
out unused space.

Usin g Di sk C opy 6 .1.2
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m Choose “Create Image from Disk...” from the Image menu and select a disk.

m Bring Disk Copy 6.1.2 to the foreground and insert a disk.
After a disk or floppy is selected, Disk Copy 6.1.2 defaults to a disk image size the
same as the partition size of the selected volume, which includes unused space.
Press the Shift key when selecting a disk in the dialog box to calculate and show
the amount of data in the disk (excluding free space). This also works when
dragging disk or floppy icons to the Disk Copy 6.1.2 window or application icon.
2

Type a name and select a format for the new disk image.

Set the default disk
image name
extension (“.img” in
this example) in the
Preferences dialog
box.

Click to mount the new disk
image after it is saved.
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Click to add a DigiSign
signature to the new disk
image after it is saved.

Choose a format for
saving the new disk
image. Use Balloon
Help or see Chapter
1 for more details on
the different formats.

3

Choose a size for the new disk image.

If for example, you want to image a folder with only 300K in it, but need to be
able to use the make floppy feature of Disk Copy 6.1.2, you would need to choose a
standard floppy size disk image size.

Choose a size for the
new disk image or
select “Custom...” to
specify an exact size.
Only 720K, 800K, 1.4
MB, and 1.7 MB disk
image sizes can be
can be used with the
make floppy feature.

When creating disk images from folders with less than 2,051.5K of data, window
and icon position information is not copied. To maintain window and icon layout,
choose the “2.5 MB” size for the new disk image.

Using Di sk Co py 6. 1.2
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You can also specify any size between 401K and 2GB by selecting “Custom...”
from the Size pop-up menu.

Type the desired disk
image size in this
box. Use the pop-up
menu to choose
blocks, kilobytes (K),
or megabytes (MB).

Converting disk images
1

To convert a disk image from one format to another, do any of the following:

m Select one or more disk images and double-click while pressing the Command
key. This only works for NDIF images (Read/Write, Read-Only, and Read-Only
Compressed).
m Select one or more disk images and drag into the Disk Copy 6.1.2 main window
while pressing the Command key (requires System Software 7.5 or later).
m Select one or more disk images and drag onto the Disk Copy 6.1.2 application
icon while pressing the Command key.
m Choose “Convert Image...” from the Image menu and select a disk image.

Click to verify the
checksum of the
selected disk image.
If the checksum fails,
the disk image will
not be converted.
Click to verify the
signature of the
selected disk image.
If the signature is
invalid, the disk
image will not be
converted.

After a disk image is selected, you will see the same standard dialog box that is
presented when creating a new disk image.
Conversion is actually creating a new image based on the original.
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2

Follow steps 2 and 3 from the previous section, “Creating a disk image.”

Disk Copy 6.1.2 will then create a new disk image based on the selected original
and save it using the size and format options. To make the converted disk image
larger than the original, choose a larger size. To make the converted disk image
smaller than the orig in a l, press the Shift key when selecting a disk in the dialog
box to calculate and show the amount of data in the disk (excluding free space).
This also works when dragging disk or floppy icons to the Disk Copy 6.1.2 window
or application icon.

Calculating and verifying checksums
Calculating disk checksums
Disk Copy 6.1.2 always calculates and includes checksums in the disk images it
creates (except Read/Write fo rm a t ), and can calculate a ch ecksum for a volume
such as a floppy or hard disk. This can be useful if you want to compare a disk
image to its source disk to ensure their contents are identical.
To calculate a checksum for a volume:

Choose “Calculate Disk Ch ecksum...” from the Utilities menu and select a disk.

Usin g Di sk Copy 6 .1.2
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The calculated ch ecksum will be displayed in the main window and written to the
log file if the “Save Log” option is selected in the Preferences dialog box.

Checksums on unlocked volumes are not very useful because any action performed
on the volume will result in a different checksum calculation. Hard disks can be
locked with various formatting utilities, such as Apple’s Drive Setup.

Verifying image checksums
Verifying the ch ecksum of a disk image helps assure that the file has not been
damaged and is not corrupted. Disk Copy 6.1.2 always verifies the checksum of a
disk image before making a floppy from it to ensure it is an exact copy.
To verify the checksum of a disk:

m Choose “Verify Image Checksum...” from the Utilities menu and select a disk
image.
m The Mount Image and Convert Image dialog boxes also have options for
verifying the checksum of a disk image before continuing to work with it.

14
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Disk Copy 6.1.2 will then verify the checksum of the selected disk image. T his can
take a considerable amount of time on large disk images.

The status of the checksum will be displayed in the main window and written to
the log file if the “Save Log” option is selected in the Preferences dialog box.
If the checksum fails, the disk image may have been altered or damaged.

Signing and verifying digital signatures
These features require the DigiSign extension. Signing disk images also requires a
valid Signer file. For more information on digital signatures, see the DigiSign
sections of the PowerShare Server, System 7 Pro, or System 7.5 do cumentation.

Adding digital signatures to disk images
To add a DigiSign digital signature to a disk image, do any of the following:

m Choose “Sign Image...” from the Utilities menu and select a disk image.
m The Save I mage dialog box also has options add a digital signature to a disk
image after saving it.

A digital signature will be added to the disk image and it will be locked. Newly
created Read/Write format disk images cannot be signed, b ecause they are altered
by any action, such as mounting.

U sing Disk Co py 6.1 .2
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Verifying digital signatures
Verifying the signature of a disk image helps assure that the file has not been
altered since it was signed. T his is helpful for authenticating the source of a file.
To verify a digital signature:

m Choose “Verify Digital Signature...” from the Utilities menu and select a disk
image.
m The Mount Image, Convert Image, and Make Floppy dialog boxes also have
options for verifying the digital signature of a disk image before continuing to
work with it.

The status of the signature will be displayed in the main window and written to
the log file if the “Save Log” option is selected in the Preferences dialog box.

About the Disk Copy log
The Disk Copy log wi ndow keeps a detailed record of all activity since the Disk
Copy application was launched:
m Each specific action (mount, create, convert, etc.).
m The elapsed time and speed (in Kilobytes per second) of each action.
m C he cksum and digital signature validity information.
m The p ercentage of space savings for disk images saved in Read-Only and ReadOnly Compressed formats.
m The results of each action.
To view the log window, choose “Show Log Window” from the Edit menu.
The contents of the log window can be saved to the “Disk Copy Log” file by
selecting the “Save Log” option in the Preferences dialog box.
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Working with DiskScripts and AppleScript

About DiskScripts
A DiskScript is a special file containing commands that instruct Disk Copy 6.1.2 to
perform an action on a list of disk images, and to optionally launch an application
with or without a specific do cument. DiskScripts are not related to, and do not
require AppleScript to run.

Executing a DiskScript
To execute a DiskScript, do any of the following:

m Select one or more DiskScripts and double-click.
m Select one or more DiskScripts and drag into the Disk Copy 6.1.2 main window
(requires System Software 7.5 or later).
m Select one or more DiskScripts and drag onto the Disk Copy 6.1.2 application
icon.
m Choose “Execute DiskScript...” from the File menu and select a DiskScript.

Click to verify the
checksum of all disk
images referenced in
the DiskScript.
Click to verify the
signature of all disk
images referenced in
the DiskScript.

Working with DiskScripts and Appl eScri pt
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Creating DiskScripts
1

Create a new file with SimpleText or any word processor and enter the content of the DiskScript.

Refer to the following sections for the specific commands and syntax.
2

Save the file as text (the default for SimpleText).

3

Change the file type to “hscr” and the creator to “ddsk.”

There are many utilities that can change the type and creator of a file.

DiskScript actions
Disk Copy 6.1.2 supports three actions in DiskScripts:
m Mount on the desktop all the disk images specified in the DiskScript.
m Launch an application (and optionally a document) after the specified disk
images are mounted on the desktop.
m Make floppies from all the floppy-sized disk images specified in the DiskScript.

DiskScript syntax
The first line of the DiskScript determines the action to perform:
First Line

Result

<blank>

Disk Copy 6.1.2 will mount all the disk images listed in the
DiskScript.

<path to application>

Disk Copy 6.1.2 will mount all the disk images listed in the
DiskScript and launch the specified application.

<path to application><tab><path to document>

Disk Copy 6.1.2 will mount all the disk images listed in
the DiskScript and launch the specified application, opening
the specified document.

<tab><tab> MAKEFLOPPY

Disk Copy 6.1.2 will make a floppy from each of the floppysized disk images listed in the DiskScript. If the“Make
Multiple Floppies” option is selected in the Preferences
dialog, clicking Cancel at the Insert Disk dialog will
continue to the next disk image.

The subsequent lines consist of the list of disk images to be operated upon. Only
one disk image can be listed per line.
If the target disk images are in the same folder as the DiskScript, each line can
consist of the name of a disk image without the path to it. If the target disk images
are not in the same folder as the DiskScript, the name of a disk image with the
complete path to it is required.
Alternatively, placing only a colon “ : ” in the second line of the DiskScript
instructs Disk Copy 6.1.2 to mount all images in the same folder as the DiskScript.

18
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DiskScript features
m All files that are not disk images in the target folder will be ignored.
m Disk Copy 6.1.2 will resolve aliases if they point to disk images.
m If a disk image fails to mount, the DiskScript stops execution and any specified
application does not launch.
m The disk images listed in the DiskScript can be a mix of any size and fo rm a t
supported by Disk Copy 6.1.2.
m When the application launched by the DiskScript quits, all disk images mounted
by the DiskScript will be unmounted and removed from the desktop, unless they
are in use by another application.

Sample DiskScripts
Mount and launch an application with a specific document
This script will mount all disk images in the same folder as the DiskScript and
launch the application “Installer” with the document “Installer Script,” which are
located on the disk named “Disk One.”
Disk One:Installer:<tab>Disk One:Installer Script
:

Make floppies of all disk images
This script will mount all disk images in the same folder as the DiskScript.
<tab><tab>MAKEFLOPPY
:

AppleScript support
Disk Copy 6.1.2 is fully scriptable, recordable, and attachable. To get a list of the
scripting commands available, use a script editor application to view the
AppleScript dictionary of Disk Copy 6.1.2.
Attachability is an easy and powerful way to extend the capabilities of Disk Copy
6.1.2. If there is a folder named “Scripts” in the same folder as Disk Copy 6.1.2, any
AppleScript droplets or compiled A ppleScripts will appear in a “Scripts” menu.
Disk Copy 6.1.2 will automatically detect and display any AppleScript droplets or
compiled A ppleScripts added while it is running when brought to the foreground.

Wo rki ng wit h Di skS cri pts a nd A pp leScript
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Preferences

All preferences are stored in the “Disk Copy Prefs” file, located in the Preferences
folder in the System Folder.

General Preferences

Allow user interaction
When this option is selected, Disk Copy 6.1.2 will present dialog boxes when
certain operations complete or fail, in addition to noting the result in the status
field. T his should be turned off if Disk Copy 6.1.2 is being called by AppleScript.
If it is not turned off, modal dialogs could appear when Disk Copy 6.1.2 is running,
preventing AppleScript from continuing execution.

Save log
When this option is selected, Disk Copy 6.1.2 will write all messages presented in
the main window status field to a file named “Disk Copy Log” in the Preferences
folder in the System Folder.

Make multiple floppies
When this option is selected, Disk Copy 6.1.2 will make multiple floppies from the
same disk image. After each floppy is complete, the I nsert Floppy dialog box will
appear until the “Cancel” button is clicked.

Confirm erases
When this option is selected, Disk Copy 6.1.2 will present a confirmation dialog
box before erasing a floppy and copying new data to it.
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Use speech
When this option is selected, Disk Copy 6.1.2 will use PlainTalk to speak dialogs
and other informational messages. This feature requires PlainTalk Text-to-Speech.

Verification and Authentication

Verify checksum
When this option is selected, Disk Copy 6.1.2 will default to verify the checksum of
disk images. This setting affects the defaults of
m the Mount Image, Convert Image, and Execute DiskScript dialog boxes
The default can be ove rr idden by deselecting the “Verify Checksum” option in
each of these dialog boxes.
m any disk image operations activated by double-clicking icons or by dragging
icons to the Disk Copy 6.1.2 window or application icon

Verify DigiSign signature
When this option is selected, Disk Copy 6.1.2 will default to verify the DigiSign
digital signature of disk images. This setting affects the defaults of
m the Mount Image, Convert Image, Make Floppy, and Execute DiskScript dialog
boxes.
The default can be ove rr idden by deselecting the “Verify Signature” option in
each of these dialog boxes.
m any disk image operations activated by double-clicking icons or by dragging
icons to the Disk Copy 6.1.2 window or application icon

Except DiskScripts
When this option is selected, Disk Copy 6.1.2 will not verify the checksum or
DigiSign digital signature of disk images referenced from DiskScripts. Disk Copy
6.1.2 will, however always verify the checksum when making a floppy.

Except remote images
When this option is selected, Disk Copy 6.1.2 will not verify the checksum or
DigiSign digital signature of disk images that reside on AppleShare servers.

Preferences
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Creating Images

Zero blocks
When this option is selected, Disk Copy 6.1.2 will write zeros to a newly created
disk image before writing data to it. This completely erases any residu al
information that is present and will ensure optimal space savings and compression
when saving in the Read-Only or Read-Only Compressed formats. It is
recommended that this option always be selected.

Add DigiSign signature
When this option is selected, Disk Copy 6.1.2 will default to adding a DigiSign
digital signature to newly created disk images after saving. This setting affects the
defaults of the Save Image dialog box. The default can be ove rr idden by
deselecting the “Add DigiSign Signature” option in this dialog box.

Mount afterwards
When this option is selected, Disk Copy 6.1.2 will default to mount newly created
disk images after saving. This setting affects the defaults of the Save Image dialog
box. The default can be ove rr idden by deselecting the “Mount Afterwards” option
in this dialog box.

Image extension
This is the default extension that Disk Copy 6.1.2 will add to the name of newly
created disk images. You will see this in the Name field of the Save I mage dialog
box.
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Special Tips

Turn off “verify checksum” when mounting disk images residing on CDs
If you are going to be working with disk images that are on a CD-ROM or other
read-only media and you are sure of the integrity of the files, deselect the “Verify
Checksum” option in the Preferences dialog for faster disk image mounting.

Not all software can be installed from mounted disk images
Some software installers look for a floppy to be in the floppy drive and cannot be
installed from mounted images. Use Disk Copy 6.1.2 to make the floppy and then
install the software.

Set up Disk Copy 6.1.2 to be launched by other kinds of disk images
With System Software 7.5 or later, you can configure your computer to have Disk
Copy 6.1.2 launch when you double-click disk images created by other disk image
utilities, such as Disk Copy 4.2 and ShrinkWrap:
m The Macintosh Easy Open (or Mac OS Easy Open) control panel must be
installed.
m Remove copies of other disk image utilities and rebuild the desktop.
m Now when you double-click on a disk image created by another utility, you will
be prompted to select an application to open the file. Select Disk Copy 6.1.2 to
make it the default. Macintosh Easy Open (or Mac OS Easy Open) will
remember the setting and use Disk Copy 6.1.2 to open similar disk images.

Use the Read-Only Compressed format
The Read-Only Compressed format has a number of advantages:
m Images take up much less space, yet mount and work as fast as other disk image
formats. This can save valuable hard drive space and shorten download times.
m Store files in Read-Only Compressed format disk images instead of creating
archives with compression utilities; just double-click to access your files. This is
es pe cially helpful for files stored on remote servers; you no longer have to copy
the archive to your local hard drive and decompress it.

S pe ci al Tips
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